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Welcome to AFH-FAST/FD 
 
AFH FAST/FD is a tool for transferring measurement data from a SAUTER force 
gauge to a PC. The connection is established via a serial cable which is connected to 
one of the RS-232 interfaces of the PC or with the included USBRS-232 converter. 
The received measurement values can be saved as XML-file and therefore be 
imported in every XML compatible software. 
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What is new? 
Version 1.0.8.7 offers the ability to control the test stand within AFH-FAST/FD (only 
FH and FL devices). You can search for new connected measurement devices and 
define a safety stop. Furthermore, the graphic can be flipped horizontally and you 
can define an action that is executed if the limit values are exceeded. 
 
- Flip graphic horizontally  
- Search for connected measurement devices 
- Safety stop 
- Control Test Stand 
 
Getting started the software 
1. Installation 
2. Preparations 
3. See the mains product features 
4. How to work with AFH-FAST/FD is described in the user interface chapter. 
5. The context sensitive help for the specific situations is always displayed with F1  
    key. 

Installation 
 
AFH-FAST/FD is distributed as a standard setup package. The product is designed 
for Microsoft Windows platform and has special hardware and software requirements 
(see System requirements) 
 
How to install? 
Execute the downloaded installer and follow the setup wizard instructions. 
On Windows Vista/7 you must allow the user rights elevation to administrative rights 
during installation. When setup is starting, you will be asked to choose the language 
of AFH-FAST/FD to be installed. Possible choices are: German and English 
 

 
 
Choose the desired language and click o.k.  
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Next the setup wizard welcome window appears 

 
 
Click the next button to display the Destination Location dialogue. Here you have the 
possibility to modify the location where AFH-FAST/FD will be installed: 

 
 
The next window gives you the opportunity to choose the installation type.  
 
Possible choices are: The application and the appropriate device list will be installed 
 
Install device list  only the device list will be installed 
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Click “Next” button to choose if a desktop icon or a Quick Launch icon should be 
created 
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The next window shows a summary of the installation options. 
Click “Install” button to install the application. 

 
 
After installation you have the option to launch AFH-FAST/FD while finishing the 
setup procedure. 

 
 
Click “Finish” button to complete installation. 
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Preparations 
Before recording measurement data from the SAUTER force gauge, there are some 
preliminary steps to be done. 
 
Connect the force gauge (or test stand and displacement measuring device, the 
length meter) with original interface cable to your PC (either directly to a serial port or 
to each of the included USB-To-Serial converter for displacement device and test 
stand. 
 
- Turn on the gauge 
- start AFH-FAST/FD program 
 
While starting, the program scans all serial ports for a SAUTER FH and a 
displacement measuring device. 
If no displacement measuring device could be found, there is a message displayed in 
the bar: 

 
 
Otherwise, if a displacement measuring device is found, the following message is 
displayed: 

 
 
Note: If you don’t have a test stand with a displacement measuring device, you will 
not be able to perform Force-Displacement measurements. You can only perform 
Force-Time measurements then. If you connect the devices after starting AFH- 
FAST/FD, you do have to close AFH-FAST/FD and restart once again to scan for the 
devices. 

System requirements 
 
AFH-FAST/FD is designed for Microsoft Windows platform and has special hardware 
and software requirements. It is distributed as a standard setup package. More about 
installation can be found in the Installation Help topic. 
Hardware:  
- IMB-compatible PC 
- at least one serial port (RS-232) a a USB-to-Serial converter 
- 256 MB RAM 
- 5 MB free disc space 
- SAUTER force measurement device (optional test stand with displacement 
measuring device). 
Operating system:  
Microsoft Windows 2000/XP/Vista/7 (32 or 64 bit) 
Other requirements:  
NET framework 2.0 
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Main features 
The following is an overview of important or interesting features of AFH-FAST/FD. 
The full list of product features can be found here: 
 
Manage serial interfaces 
To manage serial interfaces, you have to display the serial interfaces window. You 
can modify the settings of an interface like baud rate, parity etc.  
If the window for managing the interfaces is not visible, you can show it with the 
menu ViewSerial interfaces. 
 
Managing measurement devices 
To manage devices, you have to display the devices window. You can create new 
devices, change their properties or check the connection to a device. If the window 
for managing the devices is not visible, you can show it with the menu 
ViewDevices. 
 
Check device connection 
To check the connection to a measurement device, you have to display the check 
device connection dialogue. You will achieve this by a double click onto a device icon 
or by right clicking inside the device window and choosing check connection from the 
context menu. 
 
Control test stand 
To control the test stand from within the AFH FAST/FD program, you have to display 
the Control test stand dialogue. You can do this by selecting View Test stand in the 
main menu. 
 
Recording measurement series 
To record a new measurement series, you have to create a new measurement 
document by choosing main menu item File New. 
If recording a measurement series with more than 500.000 measurement values, no 
other document should be opened. 
 

Full features list 
Down below you find the full features list of AFH-FAST/FD product. Detailed 
description of individual features can be found in the User interface chapter and its 
topics. 
 
Basic features 
- Record of multiple Force-Time and /or Force-Displacement measurement series 
- Management serial ports 
- Management measurement devices 
- Display or print of the recorded measurement data in a chart 
- saves the recorded measurement series to an XML-file 
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- Multi-lingual user interface (see Installation) including context sensitive help 
- Modem look and feel, working with multiple charts in tabs, see User interface. 
Recording measurement series 
- Possibility to record multiple measurement series (Force-Time and/or Force-
Displacement). Measurement series with up to 500.000 values should be recorded 
individually) 
- Printing and previewing the displayed measurement data 
- Analogues display of current measurement value 
- Chart display of whole measurement series with full zooming capability 
 
Save / Export 
- XML: Use the Save or Save as command for saving the measurement data to an  
            XML-file 
- EMF: Use the Save picture as command for saving the Chart to an EMF-file 
- PNG: ‘Use the Save picture as command for saving the Chart to a PNG-file 
- BMP: Use the Save picture as command for saving the Chart to a BMP-file 
 
User interface 
- Modem user interface; wide set of options for setting the colored panel layouts etc. 
- Working with multiple documents in tabs 
- Wide support for clipboard and mouse dragging functionality 
 
Miscellaneous 
- Context-sensitive help in the application is always displayed by pressing F1 key. 
- Product has special requirements for hardware and for software; see System 
requirements. 
 
License 
This product is distributed as single user license (see License agreement) 

The User Interface 
 
The aim of topics in this chapter is to briefly inform about use and functionality of 
application elements in those areas where the user is currently located.  
If you cannot find the necessary information in this chapter, try to search such a topic 
in How to do it?  
 
Basic elements of user interface 
- Main menu 
- Tab bar 
- Status bar 
 
Other windows and dialogues 
- Control test stand 
- Serial interface 
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- Devices 
- Settings 
- Analogues display 
- Enlarged display 
- The About box 
 
Extensions (Add-ins) 
The interpreting of the device protocol is managed in separate modules (Add-ins). 
There is an add-in for specific device types. For downloading the latest Add-ins use 
the settings dialogue. 

Basic “elements” for user interface 
 
The following picture shows the basic elements of the user interface of AFH- 
FAST/FD product: 
 

 
 
Overview of the user interface elements: 
- Main menu 
- Tool bars 
- Tabs bars 
- Graphic area 
- Properties panels 
- Status bar 
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Main Menu 
The main menu consists of the following sub-menus: 

 
- File menu 
- Measurements menu 
- Graphic menu 
- View menu 
- Help menu 
 
File Menu 
File Menu contains the following commands: 
- New: creates a new document 
- Open: opens an existing document 
- Close: closes an open document 
- Save: saves an open document with its file name 
- Save as: saves an open document with selected file name 
- Page setup: enables the selection of a print format 
- Print: prints a document 
- Print preview: enables preview of the document to be printed 
- Exit: quits AFH-FAST/FD 
 
New 
Command New (File Menu) 
Use this command to create a new document in AFH-FAST/FD. To open an existing 
file, use the Open command. 
 
Shortcuts 

Toolbar:   
Keyboard:  STRG+N 
 
Open 
Command Open (File Menu) 
Use this command to open an existing document in a new window. You can open 
several windows at the same time. Using the window list menu, you can toggle 
between the open documents. 
New documents can be created with the New command. 
 
Shortcuts 

Toolbar:   
Keyboard:  STRG+O 
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Close 
Command Close (File Menu) 
Use this command to close all windows which contain the active document.  
AFH-FAST/FD recommends saving all changes you made to the document before 
closing it. If you close a document without saving, all changes will be lost you did 
since the last saving of the document. Before closing an unnamed document, AFH-
FAST/FD will display the dialogue filed Save As and recommends naming the 
document and saving it. 
 
You can also user the closing icon to close a document, as shown below: 

 
 
Save 
Command Save (File Menu) 
Use this command to save the document with its current name and directory. When 
saving a document for the first time, AFH-FAST/FD will display the Save As dialogue 
field, so that you can name your document. If you want to change the name and 
directory of an existing document, you can also use the Save As command. 
 
Shortcuts 

Toolbar:   
Keyboard:  STRG+S 
 
Save as 
Command Save as (File Menu) 
Use this command to save and name the active document. AFH-FAST/FD will 
display the dialogue field Save As, so that you can enter a name for your document.  
To save a document under its existing name and directory, use the Save command. 
 
Save as dialogue 
The following options will enable you to determine the place and the name of the file 
you want to save: 
- File name: Enter a new file name to save the file with a different name.   
  AFH-FAST/FD will add the extension you selected in the field file type to the name. 
- Drives: Select the drive where you want to save the file. 
- Directories: Select the directory where you want to save the document. 
- Network: Use this button to allocate one of your drives to a network drive. 
 
Search devices 
Command Search devices (File Menu) 
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Use this command to search for new connected measurement devices and serial 
ports. 
 
Shortcuts 

Toolbar:   
 
Page setup 
Command Page setup (File Menu) 
This dialogue allows you to change the settings for printing paper format 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Print 
Command Print (File Menu) 
Use this command to print a document. When using this command, Print dialogue 
field appears, where you can enter the page range to be printed, the number of 
copies, the target printer and other options concerning printer setup. 
 
Shortcuts 

Toolbar:   
Keyboard:  STRG+P     
 
Print Preview 
Command Print Preview (File Menu) 
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Use this dialogue if you want to see how the graphic representation will look like on 
paper 
 
 
 
 
 
 
 
 
 
 
 
 
 
Measurements Menu 
Measurements Menu contains the following commands: 
- Start: Starts the capturing of measurement data 
- Pause: Pauses the capturing of measurement data 
- Stop: Stops the capturing of measurement data 
- Send manually: Sends the defined device command to the device only once 
- Send timer: Sends the defined device command to the device in regular intervals 
 
These commands are also available in the measurements toolbar: 

       Force/Time measurements 
 

 Force/Displacement measurements 
 

 
Graphic Menu 
The Graphic Menu contains the following commands: 
- Display grid: Displays or hides a grid in the graphic view 
- Save graphic as: Saves the graphic to a file (EMF, PNG, BMP) 
- Copy: Copies the graphic to the Windows clipboard 
 
View Menu 
The View Menu contains the following commands to manage the serial interface, 
devices and program settings: 
- Serial interfaces: Shows or hides the window to manage the serial interfaces 
- Devices: Shows or hides the window to manage devices 
- Settings: Opens the window to manage the program settings 
- Status bar: Shows or hides the status bar 
- Test stand: Shows or hides the control test stand dialogue 
 



AFH-FAST/FD-BA-e-1514   15 

Help Menu 
The Help Menu contains the following commands: 
- Contents: Shows the contents of this help file 
- Index: Shows the index of this help file 
- Search: Enables you to search in the help file for specific terms 
- About: Displays more information about the version AFH-FAST/FD. 
 
Toolbars 
There are two different tool bars in AFH-FAST/FD: One for the main program 
features and one for graphical features. 

 

Main program features 
New - Creates a new document 
Open - Opens an existing document 
Save - Saves an open document with its file name 
Print - Prints a document 
Search devices - Search for recently connected devices 
Help - Shows this help file 

Graphical features 
Copy - Copy the graphic to the windows clipboard 
Grid - Displays or hides the grid 
Zoom all - Zoom the graphic view that all measurement data is visible 
Zoom previous - Goes back to the last zooming state 

Window list 
Use this menu to toggle between the opened documents 
 
 
 
 
 
 
 
 

Tab bar 
The tab bar is designed to switch between currently opened measurement series. 

 
 
You can switch and / or close visible tabs (pages) or select them from the windows 
list. 
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Switching between documents can be realized (besides mouse click on the tab) by 
keyboard - via shortcuts Ctrl+Tab and Shift+Ctrl+Tab. Shortcut for closing current 
tab (page) is Ctrl+F4. 
Order of tabs can be changed via drag & drop functionality. 
By right clicking on the tab of a specific measurement series, a context menu 
appears to show an analogous and/or enlarged display. 
 
Gauge - Show an analogous display, which show s the current measurement value 
Enlarged display - Show an enlarged display, which show s the current measurement 
value. 

Graphic view 
The graphic view is for displaying the measurement series as a chart representation. 
You can change the appearance in the Settings dialog. There you can choose the 
background color, the graph color etc. 

 
Status Bar 
The status bar is displayed at the bottom of the AFH-FAST/FD window. Using the 
Status Bar command in the View menu you can show or hide the status bar. 
 
Other windows and dialogues 
 
As part of the application, there are more windows and dialogs, which are not 
specifically described in the previous help topics. Here are the links to detailed 
description of these dialogs. 
Look especially at Settings dialog. 
 
List of miscellaneous windows and dialogs 
- Control test stand dialogue 
- Serial interfaces  
- Devices 
- Settings 
- About box 
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Control test stand dialog 
This dialogue is used for controlling the test stand. It is only available if a 
displacement measurement device has been found at program startup. If no such 
device has been found, the menu item to display the dialog is disabled. 

 
The dialog contains three buttons to control movement of the test stand, one button 
to reset the force gauge to zero and a movement indication showing the current 
movement state of the test stand. 
 
Note: 
If you connect the devices after starting AFH-FAST/FD, you have to close it and 
restart once again or run the command Search devices, to scan for the recently 
connected devices. 

Serial interfaces 
This window shows all serial interfaces available in the computer. To view or modify 
the settings for a special interface, you have to choose the interface. In the lower 
window you can then modify the properties. 
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Devices 
 
This window displays all created devices. To modify the properties of a specific 
device, you have to choose the device and customize the properties in the lower 
window. 

 

Settings  
 
The Settings dialogue is the basic place to set or modify application parameters. 
Some parameters (e.g. changes in device properties) are stored automatically and 
some (the appearance of the chart view) are additionally available in the toolbars of 
AFH-FAST/FD. But the essential parameters of the application can be found in this 
dialog box. 
This dialog is divided into categories (Graphic, Display and Addin), according to 
content and the importance of parameters. In this topic you can find the description of 
each category and parameter. 
 
Graphic 
 
Color:- change the background color of the chart view, the color of the data graph or 
the color of the grid.  
Graphic: enables antialiasing to improve the graphic quality 
Measurement graph - selects if grid should be visible or hidden, if there will be lines 
drawn between measurement points or if the measurement values are represented 
by points. 



AFH-FAST/FD-BA-e-1514   19 

 
 

Display 
Device - set the color of the out of limit area, the needle color or the scale color 
Enlarged Display - choose background color, font and foreground color of the 
enlarged display 
 

 
 

Add-in  
Download - download latest add-ins for interpreting measurement device protocols 
(an internet connection is needed) 
Delete - delete add-ins from hard disk which are not needed 
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Analogous display 
 
This dialogue displays an analogous representation of the current measurement 
value. The out of limits area can be marked with a different color as described in the 
Settings dialog. 
 

 
 
To show this window, press right mouse button 

 

Enlarged display 
 
This dialog displays the current measurement value in an extra window , which can 
be enlarged as desired. The font and color can be modified as described in the 
Settings dialogue. 
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About the application 

 This dialog displays the logo, build version and possibly additional information 
about the AFH-FAST/FD product. 
  
          How to do it? 
In this help section you can find examples, that can help you in understanding the 
tasks, which you can perform in the AFH-FAST/FD product. The table of contents 
below contains links to those examples. 
 
Exporting measurement data 
You can export the measurement series to EXCEL 
 
Manage serial interfaces 
The program displays all the existing serial interfaces. To modify the settings of an 
interface, you have to choose the icon of the interface and modify the settings (baud 
rate, parity etc.) in the lower part of the window. If the window for managing the 
interfaces is not visible, you can show it ith the menu View->Serial interfaces. 
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Manage measurement devices 
The program displays all the created devices. In this window you can create new  
devices, delete devices, change their properties or check the connection to a device. 
If the window for managing the devices is not visible, you can show it with the menu 
View->Devices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Recording Measurement series 
To record a measurement series you have to do the following steps: 
Create a new measurement document by choosing File->New within the main menu 
Choose the device from which you want to receive data 
Modify the properties of the device and measurement to fit your needs 
Switch to Measurement menu. 
Start measurement, record measurement data either manually or timer controlled 
Stop measurement and save or print data.  
Close measurement document. 
 
Recording a measurement series 
 
1. Create a new measurement document 
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2. Choose device from the list of all previously defined devices 

 
 
3. Modify the properties of the device and/or measurement to fit your needs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The only device property to modify is Sign reversal. If this property is set to Yes, the 
sign of the measurement data will be inverted, e.g. if device sends 40N the 
measurement value will be -40N. 
All other device properties are taken from the device defined in the device window. 
 
The following measurement properties can be modified: 
 
Date/Time will be entered automatically w hen starting measurement 
 
Device limits enable you to receive only data within a predefined bandwidth 
 
Displacement reversal will be used to reverse the displacement values (only visible if 
Measurement type is equal to Force-Displacement) 
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Lower Limit of measurement device (only active if Device limits is equal yes) 
Measurement type can be Force-Time, Force-Displacement series or read memory 
Mirror horizontally is used to flip the graphic view horizontally 
Time interval of sending device command for requesting data (This setting affects the 
number of stored values â €‹â €‹for long-term measurements and thus the max. 
measurement period. A maximum of 500,000 Force /Displacement or Force /Time 
values can be stored) 
 
Title of measurement for saving and displaying data 
 
Upper Limit of measurement device (only active if Device limits are equal yes) 
 
4. Switch to Measurement Menu 
After switching to the measurement menu you are able to start recording a 
measurement series. 

 
 
Depending on the measurement type this menu looks a little bit different:  
Force-Time 

 
 
Force-Displacement 
 
 
 
Export measurement data to EXCEL 
To export a measurement series to EXCEL (or any other software capable to import 
XML-format) you just save the measurement document by Save or Save as. To 
import the XML-file into EXCEL you use the EXCEL open command (file menu), 
select in the file type dropdown list XML Files and choose the desired measurement 
document. 
 
Create a device 
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To create a new device, right click within the Devices window for displaying the 
context menu. Then select New. The Create device dialog appears. 
 
Choose the device type from the drop down list, enter name (or accept default name) 
of the device and click OK. The new device should appear in the device window. 
 

 
 
Delete a device 
 
 
 
 
 
 
 
 
To delete one or multiple devices, select the devices to be deleted then right click 
within the device icon for displaying the context menu. Then select Delete. 
To confirm deletion, press ok in the message box. 
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Modify Device settings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this property panel you can display or rather modify all device related settings. On 
the left is the name of the property and on the right the corresponding value. The 
lower panel shows a short description for the property. 
 
The devices have the following properties:  
 
- Device command for stable reading Device type 
- max, min measurement ranges 
- Device name 
- Number of data bytes the device is sending 
- Readability 
- Sign reversal (the received data value w ill be inversed) Connection (COM port to      
  which device is connected) Unit 
- Safety stop 
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Check device connection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With this dialogue you can check if a device is connected to the PC and is able to 
communicate with AFH-FAST/FD. 
To establish a connection, press the Connect button. If COM port is opened without 
error, the red LED is highlighted and the communication parameters will be 
displayed. 
If the device is sending data, it is displayed in the Received data window in both, 
ASCII and HEX. 
 
Use the Clear data button to remove all received data from the window . 
 
Use the Send command button to send the previously defined device command to 
the device. 
Before closing this dialogue, you have to disconnect from the device by pressing the 
Disconnect button. 
 
Modify serial settings 
 
 
 
 
 
 
 
 
 
 
 
In this property panel you can modify all interface related settings. On the left is the 
name of the property and on the right the corresponding value. The lower panel 
shows a short description for the property. 
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The serial interface has the following properties:  
- COM port number 
- Baud rate (the transmission speed in bits/sec)  
- Number of data bits (number of data bits per byte)  
- Handshake protocol 
- Parity 
- Number of stop bits 
 
Control test stand 
 
The Control test stand dialog enables you to control the test stand and to reset the 
force measurement gauge. It can be displayed only if a displacement measurement 
device has been found at program start. Otherwise the menu item to show this dialog 
will be disabled. 
 
 
 
 
 
 
Control movement of the test stand 
 
 
 
 
With these three buttons you can cause the test stand to move upward, downward or 
you can stop the movement. The movement display in this dialog will reflect the 
actual movement. 
 
Reset force measurement gauge 

 
Use this button to reset the force measurement gauge to zero. 
 
Display current movement of the test stand 
 

 
This movement indication shows, if the test stand is moving upward, downward or if it 
rests. 
 
 
 



AFH-FAST/FD-BA-e-1514   29 

Additional help resources 
Here you can find links to additional help authoring resources (reference manuals, 
etc.). 
Reference manuals 
AFH FAST/FD documentation 
Measurement device manual 
 
Links 
Sauter GmbH, http://www.sauter.eu/ 
 
AFH-FAST/FD - License agreement 
 
Except where otherwise noted, all of the documentation and software included in the 
AFH FAST/FD package is copyrighted by SAUTER GmbH. Copyright (c) 2009-2012 
SAUTER GmbH. All rights reserved. 
 
Liability disclaimer: 
 
This software is provided "as-is," without any express or implied warranty. In no event 
shall the author be held liable for any damages arising from the use of this software. 
 
Permissions: 
 
1. You may install and use one copy of the software product, or in its place, any prior 
version, on a single computer. You may also store or install a copy of the software 
product on a storage device, such as a network server, used only to install or run the 
software product on your other computers over an internal network; however, you 
must acquire and dedicate a license for each separate computer on which the 
software product is installed or run from the storage device. A license for the software 
product may not be shared or used concurrently on different computers 
 
Restrictions: 
 
1. You may not redistribute this software, the distribution package must not be 
modified in ANY W AY. 
 
2. You must not emulate, clone, rent, lease, sell, modify, decompile, disassemble, 
otherwise reverse engineer, or transfer any version of the software, or any subset of 
it. Any such unauthorized use shall result in immediate and automatic termination of 
this license and may result in criminal and/or civil prosecution. 
 
Sauter GmbH 
e-Mail: info@sauter.eu 
www : http://www.sauter.eu 
 

http://www.sauter.eu/
mailto:info@sauter.eu
http://www.sauter.eu/
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